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1. Lwu y quan trong

S6 tay st dung dién t& nay danh cho moi
nguw®i dung str dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay trwdc khi st dung man hinh. Sé tay
bao gébm nhirng théng tin va cac lvu y
quan trong lién quan dén viéc s dung
man hinh.

Ché dd bao hanh cta Philips ap dung v&i
diéu kién la san pham phai dwoc st dung
dung cach theo muc dich st dung, theo
cac hwdng dan hoat déng cung vai viéc
xuét trinh héa don gbc hoéc bién nhan
tién mat ghi rd ngay mua, tén ngudi ban,
mAu ma va ma sb san xuét cta san pham.

1.1 Lwu y an toan va bao dwéng

) canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu ré trong tai liéu nay cé thé
khién nguoi dung dé bi dién giat, gap cac
rdi ro vé dién va/hodc co hoc.

Hay doc va thwe hién theo cac hwéng dan
sau khi két ndi va str dung man hinh may
tinh:

Hoat dong

« Hay dat man hinh & khu vyc khdong cé
anh sang truc tiép clia mat, anh sang
riec c6 cwong dé6 manh va cach xa
bat ky ngudn nhiét nao khac. Bat man
hinh lau ngay trong méi trwdng nay cé
thé khién cho man hinh bj bac mau va
hong.

« Di chuyén moi dé vat c6 thé roi vao
cac 16 thdng gid cia man hinh hodc
ngan can qua trinh lam mat thich hop
cla cac thiét bj dién tlr bén trong man
hinh.

« Khong bit kin cac 16 thdng gi6 trén vo
man hinh.

« Pam bado d&t man hinh & gan noi cé
phich cdm va 6 cédm dién.

« Néu tdt man hinh bang cach rut cap
ngudn hoéc day dién DC, hay doi 6
giay trwédc khi cdm cap ngudn hoac
day dién DC dé man hinh hoat déng
binh thwdng.

« Hay ludn dung cap nguén chuan duoc
cap bdi Philips. Néu thiéu cap nguén,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tdm théng tin tiéu dung
cham s6c khach hang)

« Khéng dat man hinh & noi bi chan
déng hay va cham manh khi dang
hoat déng.

« Khéng dap hoac lam roi man hinh khi
dang hoat dong hodc khi di chuyén.

Bao dwdng

« P& man hinh khéng bj héng, khéng dé
nén qua manh [én mat man hinh LCD.
Khi di chuyén man hinh, hay ndm chat
khung man hinh dé& nhéc 1én; khéng
nhAc man hinh bang cach dat ban tay
hoac ngdn tay Ién mat man hinh LCD.

« Rt phich cdm man hinh néu ban khéng
dinh s dung né trong thoi gian dai.
Rt phich cdm man hinh néu ban can
lau chui man hinh bang mét miéng

vai hoi wét. Ban co thé lau man hinh
bang vai kho khi da ngat dién. Tuy
nhién, drng bao gio dung dung mai
hiru co, chdng han nhw cdn hodc cac
chét 1dng cé ngudn gbc tlr amoniac dé
lau man hinh.

« Pé tranh nguy co bj dién giat hoac
héng vinh vién bd man hinh, khéng
dat man hinh & noi c6 bui, mwa, nwéc
hodc & noi qua am wét.

«  Néu man hinh bi wét, hay lau n6 bang
vai khd cang sém cang tét.

« Néu chét la hoac nwéc dinh vao man
hinh, hay ngéat dién ngay va rat cap
ngudn. Sau dé lau sach chét la hoac
nwéc réi givi man hinh dén trung tam
bao dwdng.



Khéng cat gitr hodc st dung man hinh
@ noi c6 nguon nhiét, anh nang tryc
tiép hodc qua lanh.

Dé duy tri hoat ddng tdi wu ciia man
hinh va s dung né trong th&i gian dai,
hay dung man hinh & noi ndm trong
gi¢i han nhiét dé va dé am sau.

« Nhiét do: 0-40°C 32-95°F

« D6 a&m: 20-80% RH

Théng tin quan trong vé Thir néng/Anh
béng ma.

Ludn bat trinh bao vé man hinh
chuyé&n déng khi ban khéng st dung
man hinh. Ludn bat irng dung lam maoi
man hinh dinh ky, néu khéng, man
hinh ctia ban sé hién thi nhirng ndi
dung tinh khéng thay déi. Hién thi lién
tuc cac anh tinh trong mét thoi gian
dai co6 thé gay ra hién twong “anh thor
néng”, con dwoc goi la “anh ao” hay
“anh béng ma”, trén man hinh cia
ban.

“Anh th&r ndng”, “Anh &o” hay “Anh
bong ma” la hién twong phd bién trong
céng nghé man hinh LCD. Trong hau
hét cac trwdng hop, hién twong “anh
thtr n6ng” hoac “anh ao” hay “anh
bong ma” sé& dan dan bién mét sau
mot thei gian man hinh bi ngét dién.

) canh bao

Khéng thé bat anh bao vé man hinh, hoac
tng dung cap nhat man hinh dinh ky c6
thé gay ra cac sw cb “thtr ndbng” hodc “anh
sau” hoac “anh bong ma” nghiém trong
von sé khong bién mét va cling khéng

thé khéc phuc. Thiét hai vira néu khong
bao gdm trong chinh sach bdo hanh cua
chung toi.

Dich vu

Chi nhan vién dich vu chuyén mén
m&i dwoc mé vo boc man hinh.
Néu can moi tai liéu hwéng dan dé
stra chira hoac tich hop man hinh,
hay lién hé v&i trung tdm dich vu tai

dia phwong ban. (vui long tham khao
chuwong “Trung tdm théng tin tiéu
dung”)

Dé biét théng tin vé viéc van chuyén,
vui long tham khao muc “Théng so k§
thuat”.

Khéng dat man hinh trong xe hoi/cdp
xe dwéi anh nang truc tiép.

& Ghicha

Hay tham khao y kién cua ky thuat vién
dich vu néu man hinh khéng hoat déng
binh thwdng ho&c néu ban khéng chac
phai thwc hién quy trinh nao khi da lam
theo cac hwédng dan hoat ddng néu trong
sb tay nay.



1.2 Mb ta biéu twong

Cac muc phu sau day mo ta cac quy wéc
vé biéu twong dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bo sb tay nay, cac doan chiy
c6 thé di kém biéu twong va dwoc in dam
ho&c in nghiéng. Cac doan nay bao goém
cac ghi cha, lwu y hoac canh bao. Ching
dwoc st dung nhw sau:

& Ghi chu

Biéu twong nay cho biét cac théng tin
quan trong va cac bi quyét giup ban tan
dung tét hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac thong tin gitp
ban biét cach tranh duwoc sy ¢ hdng hoc
tiém an dbi véi phan cirng hodc méat div
liéu.

) canh bao

Biéu twong nay cho biét sy tdn thuwong
co thé tiém 4n va gilp ban biét cach tranh
dwoc sy cd do.

Mét s6 canh bao c6 thé xuét hién & nhiéu
dinh dang va cé thé khéng di kém moét
biéu twong. Trong nhirng trwdng hop nay,
cach thirc trinh bay cu thé clia canh bao
do dwoc quy dinh béi co quan chirc nang
lién quan.

1.3 Vvt bé san pham va vat liéu
doéng goi

Thiét bj dién & dién t& bj virt b6-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may

not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.



Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Cai dat man hinh Bl Lap chan aé

1. D&t man hinh nam sap trén bé mat
mém min, can than dé tranh lam tray
2.1 Lap dat xwoc hodc héng man hinh.
2. Gén/truo’t than dé vao man hinh cho
El Nbi dung g6i hang dén khi n6 kh&p vao vi tri.
Start

3. Gilr chan dé man hinh bang ca hai tay
va lap chat chan dé vao tru gde.

Cap am thanh
(233V5QABP, 233V5QHABP)

* Depends on the country.

Display design may differ from that illustrated



El Két ndi véi PC
233V5QSBP

PHILIPS

X)
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@ Dau vao ngudn dien AC

@ Diu vao VGA

© Dau vao DVI-D (c6 sén cho cac mau
vira chon)

O Khoda chdng trom Kensington

233V5QABP

PHILIPS

0\, O
Wif

@ Dau vao ngudn dien AC

© Dbiu vao VGA

© Diu vao DVI-D

@O bau ra tai nghe

© Dau vao am thanh

0O Khoa chéng trom Kensington

AUDIO 7}

233V5QHABP:

PHILIPS

© Dau vao ngudn dién AC

© Dbiu vao VGA

© Dbau vao HDMI

@O Dau ra tai nghe

© Diu vao am thanh

0O Khoa chéng trom Kensington

Két néi véi PC

1. C&m chéat cap ngudn vao mat sau cla
man hinh.

2. Tat may tinh va rat cap ngudn.

3. Cam cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

4. Cam cap ngudn clia may tinh va cap
nguon cdia man hinh vao 6 cam dién
gan doé.

5. Bat may tinh va man hinh. Néu man
hinh hién thi hinh anh thi qua trinh cai
dat da hoan tat.



2.2 Str dung man hinh

El Mb ta mat trwdc cha san pham

lllllll

233V5QSBP

(5]
AUTO/VY  [D/A 0-/4 /0K Q)
© © o006 o o

233V5QABP, 233V5QHABP:

BAT va TAT ngudn man
| .

o O hinh.

Truy nhap menu OSD.
® =) /0OK|Xac nhan diéu chinh menu

OSD.
©® 4« |Trévé mirc OSD trude.
O | & |Chinh dd sang.
© | A V¥V Chinh menu OSD.
® [ |bbidinh dang hién thi.
©® AUTO |Tw ddng chinh man hinh.

(5)
AUTO/ W -|E1 /A /O / 4\ S { 0K d|)
(7] (6] O 6 0 (1)
BAT va TAT ngudn man
| .
9 O hinn
Truy nhap menu OSD.
O /0K |Xac nhan diéu chinh menu
OSD.
© 44 Trévé mirc OSD trudec.
©® & Chinh dd sang.
© | A V¥V Chinh menu OSD.
O { [Chinh am lwong loa.
©@ AUTO Tw ddng chinh man hinh.




. Cai dat man hinh
E1 M6 ta menu Hién thi trén man hinh

Hién thj trén man hinh (OSD) la gi?
Hién thj trén man hinh (OSD) la mét tinh

nang c6 & moi man hinh LCD cuda Philips.

N6 cho phép nguwdi dung diéu chinh hoat
ddng cua man hinh hoac chon cac chirc
nang cGa man hinh truc tiép théng qua
mot ctra s& huwéng dan hién thi trén man
hinh. Mt giao dién hién thj trén man hinh
dé s dung dwoc thé hién nhw sau:

233V5QABP:

. Picture

q Audio

n Language

233V5QSBP:

= I " VGA . :
npu ————
d 5" DVI .

Picture

)
D]
3 Language
>)

Colod
»§ 0SD Settingy

v

233V5QSBP (ddi véi mau Analog):

Picture —_————————————————
Brightness < LEEEEENnn 100
) Contrast < 1 50
[[] Colorl

SmartContrast . 0ff

Gamma e 22

Pixel Orbiting * On

m 0SD Settings

Setup

233V5QHABP:
R
g HDMI
1 o

" Color

--- Language

v

Hwéng dan co ban va don gian vé cac
nat diéu khién

Trong menu OSD minh hoa & trén, ban cé
thé nhan Y A cac nut & g& mat trwdc cla
man hinh dé di chuyén con trd va nhan nat
OK dé xac nhan lwa chon hodc thay dbi.



. Cai dat man hinh

Menu OSD

Dwéi day la tbng quan vé co ciu cla
menu Hién thi trén man hinh. Ban c6 thé
st dung co’ cau nay lam théng tin tham
khao khi mudn thyc hién cac diéu chinh
khac sau nay.

Main menu Sub menu
— VGA
— Input — DVI (available for selective models)
— HDMI (available for selective models)
— Picture Format — Wide Screen, 4:3
— Brightness — 0~100
| Picture — Contrast — 0~100
— SmartContrast — On, Off
— Gamma — 1.8,20,22,24,2.6
— Pixel Orbiting — On, Off
— DPS — On, Off
(available for selective models)
L— Over scan — On, Off
(available for selective models)
— Volume — 0~100
— Audio — Stand-Alone — On, Off
(available for L Mute — On, Off

lecti del
selective models) L Audio source — Audio in. HOMI
(available for selective models)

— Color Temperature — 6500K, 9300K

—— Color — sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
—— Language — English,Espafiol,Francais,Deutsch,|taliano,

Portugués,Pycckui, f&] K F1 3, Tirkge,
Nederlands, Svenska, Suomi, Polski, Cestina
8= 01, BAEE, Maryar, YkpaiHcbKa,
Portugués do Brasil, EN\nvikry, Z# A 3

— Horizontal — 0~100
— Vertical — 0~100

— OSD Settings
— Transparency — Off,1,2,3,4
— OSD Time Out — 55, 10s, 20s, 30s, 60s
— Auto

— Setup
— H. Position — 0~100
— V. Position — 0~100
—— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
I— Reset — Yes, No
L Information

El Thong bao vé do phan giai

Man hinh nay duorc thiét ké dé hoat dong
t6i wu véi d6 phan giai gbc la 1920 x 1080
@ 60 Hz. Khi dwgc chinh sang dé phéan
giai khac, man hinh sé hién thj mot théong
bao: Dung 1920 x 1080 @ 60 Hz dé dat
két qua tot nhét.

Ban co thé tat thong bao hién thj do phan
giai goc tir muc Setup (Cai dat) trong
menu OSD (Hién thj trén man hinh).

E! Tinh nang vat ly
Nghiéng




@ Ghi chu
Man hinh nay chap nhan giao dién 1ap dat
tuan tht chudn VESA 100mm x 100mm.

2.3 Thao dé va chan dé

El Thao chan dé

Trudc khi bat dau thao chan dé man
hinh, hay thwc hién theo cac hwéng dan PHILIDS
bén dwéi dé tranh moi thiét hai hay chan
thwong co thé xay ra.

100mm

1. Dat man hinh ndm sép trén bé mat
min, can than dé tranh lam tray xuwdéc
hoac héng man hinh.

2. An vao cac kep khoa dé thao chan dé
ra khoi tru dé.

10



3. To6i wu héa hinh anh

3.1 SmartContrast

Kl pélagi?

Coéng nghé ddc dao vdn linh hoat phan
tich ndi dung hién thj va tw déng téi wu
hda ty I1é twong phan cia man hinh LCD
dé mang lai d6 rd nét va trai nghiém xem
tdi wu, tdng mrc dén nén dé hién thi
nhirng hinh anh sang ré hon, sac nét hon
va sbng dong hon hay gidm mirc dén nén
dé hién thj ré hinh anh trén phong nén téi.
Bl Sao t6i phai can né?

Ban muén hién thj ndi dung rd nét cung
cam giac thoai mai nhéat khi xem moi loai
néi dung. SmartContrast sé linh hoat chinh
do twong phan va mrc dén nén dé hién
thi nhirng hinh anh choi game hay video
cwe rd, sdng ddng va sac nét hay hién thi
ndi dung chi¥ ré rang dé doc cho cac (rng
dung van phong. Bang cach gidm viéc tiéu
thu dién clia man hinh, ban sé tiét kiém
dwoc chi phi ndng lwong va kéo dai tudi
tho cho man hinh cua ban.

El cach hoat dong?

Khi ban bat ché dd SmartContrast, no sé
phan tich ndi dung dang hién thij trong
thwc té dé chinh mau sic va mat do dén
nén. Chrc nang nay sé linh hoat tang
doé twong phan dé mang lai cho ban trai
nghiém giai tri tuyét voi khi xem video
hoac choi game.

3.2 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i clia
Phillips cho phép ban diéu khién man hinh
qua giao dién dd hoa 3o tién dung. Cac
diéu chinh phtrc tap 1a nhivng gi thudce

vé qua khir vi phan mém than thién voi
ngwdi dung nay sé hudng dan ban qua
viéc tuy chinh d6 phan giai, hiéu chinh
mau, diéu chinh déng hd/géc pha, diéu
chinh diém trdng RGB (Dd-Luc-Lam), v.v...

1

Trang bi cdng nghé méi nhét vé thuat toan
I6i xt ly va phan &ng nhanh, phdn mém
chay bang anh ddng bat mat thwong thich
véi Windows 7 nay san sang nang cao trai
nghiém cua ban v&i man hinh Philips!

Kl cai dat

« Thwc hién theo chi dan va hoan tat quy
trinh cai dat.

« Ban c6 thé kh&i ddng phan mém sau
khi hoan tat cai dat.

« Néu mudn khéi ddng sau, ban co thé
click phim tat phdn mém trén man hinh
nén ho&c thanh cdng cu may tinh.

PHILIPS

Wizard (Thuat si) khéi déng lan dau

« Lan dau khi cai dat phan mém
SmartControl Lite, n6 sé tw ddng vao
Wizard (Thuat s7) khéi dong lan dau.

« Thuat si nay s& huwéng dan ban théng
qua viéc diéu chinh tirng bwéc vé hiéu
suat man hinh.,

« Sau nay ban ciing c6 thé vao menu
Plug-in (Bb sung) dé bat thuat sf.

« Ban c6 thé chinh cac tuy chon khac
qua giao dién Standard (Chuan) ma
khéng can thuat si.



® SmartControl 2 - Philips 22581 (C530715000001) () X

SmartControl Lite PHILIPS

Wizard
You'l need to calbrate your displey to get the most

accurate color. We encourage you to use the simple
tuning process by selecting the Start Wizard button.

This process involves a series of steps that wil let you
tune your display and save the settings.
\ 1. Choose the Start Wizard button.
Q 2. Follow the steps outlined in this process.
3. for fi

Save your settings for future use.
Adjust Audio

\g Auto Pivot
-

Color Tnput
.
@ o
, B
Options Presets
\g Mutti Monitors
Help

Start Wizard

El Kh&i dong bang giao dién Standard
(Chuén):

Menu Adjust (Diéu chinh):

« Menu Adjust (Diéu chinh) cho phép
ban chinh Brightness (D6 sang),
Contrast (D6 twong phan), Focus
(Trong tam), Position (Vi tri) va
Resolution (B phan giai).

« Ban c6 thé lam theo chi dan va thyc
hién diéu chinh.

* Lénh Cancel (Huy) sé hdi nguoi dung
xem ho c6 muodn huy tién trinh cai dat
hay khéng.

1 SmartContral 2 - Philips 22581 (CS30715000001) |7 (%

SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil result in a loss of

detailin darker image arezs. Adjust the Brightness for

the best possble picture quality.

. Lower the Brightness to the minimum level.
Raise the Brightness to the desired level.

. Adjust the Brightness as needed to achieve
an equal separation of the stripes.

D

Adijust
Brightnass
\g Contrast
Color an
— Focus Brightness 100
= Uik
Pasition
7
e FF Unda Reset
Resolution

®

Help

12

B SmartControl

SmartControl Lite

il

Adjust
Brightness
\g Contrast
Color AR
g Focus
gy
@ Posttion
Options %
Resolution

®

Help

B smartcontrol

SmartControl Lite

R

Adjust
Brightness
\g Contrast
Color
5 Focus
b
\g Position
Options
W
Resalution

®

Help

W smartcontrol

SmartControl Lite

il

Adjust
Brightness
\g Contrast
Color 2
Focus

Pj'nn

Options FF

Resolution

L

Help

2 - Philps 22581 (C530715000001) £%1%
PHILIPS

Contrast
Adiust the Contrast (use the slider) to keep detais in
lighter image areas.

1. Raise the Contrast until the numbers 1 and 2
are no longer visble.

2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visible.

Contrast 50
- { +

Undo Resat.

2 - Philps 22581 (€530715000001) {F§ X
PHILIPS

Focus

Your display’s timing needs ta be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are still visble, you'l need

to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen.

pitch 50

- +

Phase 17

- Q +
Undo Auto Setup

2 - Philps 22581 (€S30715000001) (7§ X
PHILIPS

Position

Use the Position buttons to center the image on
your display. Using this tool, you can position the image
up, down, left, or right.

1. Use the Up/Down buttons to center the image

vertically.
2. Use the Left/Right buttons to center the image
harizontally.
Undo Resat




Menu Color (Mau):
Menu Color (Mau) cho phép ban chinh

T smartControl

SmartControl Lite

Brightnass

R;solut»on

2 - Philips 225B1 (CS30715000001) i X
PHILIPS

Resolution

You are currently at a Preferred resolution. For your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resolution.
If your display is at 2 Non-Preferred resolution, click
on the Preferred button to change your resolution to
Preferred.

™ Enable Resolution Notffier

Picture Format
I~ 4:3 aspect ratio

Preferred

mau RGB (DPoé-Luc-Lam), Black Level
(D6 t6i), White Point (Diém trang),
Color Calibration (Hiéu chinh mau).

Ban co thé lam theo chi dan va thuc

hién diéu chinh.

Tham thdo bang bén dudi dé hinh
dung co ban vé muc menu phu trén
thoéng tin nhap cda ban.

Vi du Color Calibration (Hiéu chinh

mau sac):

B SmartControl

SmartControl Lite

U m

Adiust RGE
\5 Bhﬁ Level
Color Wihite Point

Display Gamma

‘) + ﬁ
= .

Options Calibration

Help
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Black Level

Improperly adjusted Black Level wil resut in a loss of
detailin darker image areas. Adjust the Black Level for
the best possible picture guality.
1. Adjust the black level of the Red, Green, and
Blue using the sider bars.

Red 50

= tu?

Green 50

= &

Blue 50

= &
Undo Reset
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W smartcontrol

SmartControl Lite

i

)

Adjust RGB

Black Level

Color Whie Point

Display Garmma
L

Options Callbration

gad

Help

" W smartControl

SmartControl Lite

)

Adjust RGB
Black Level
Color White Point
=
= ks
Display Gamma
L
Options Callbration
Help

W SmartControl

SmartControl Lite

1)

Adjust RGB
Black Level
Color White Point
=
)
Display Gamma
Options Callbration

Help
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White Point

White Point is the point at which equal combinations
of red, green, and blue light at full intenstty create
white. This effects the overall color quality. For the
most accurate colors click the Reset button then
select the White Point.
1. Please select the White Point value for the best
passble color quality.

White Point 6500K
= o +

Undo Reset

2 - Philips 22581 (£S30715000001) 2 X
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Display Gamma

Gamma Is 3 component of the pixel brightness in a
display. A lower Gamma value produces brighter pixels
and a higher Gamma value produces darker pxels. The
defauft value for Gamma is 2.2.

To adjust Gamma, SmartImage must be set to Off.
Click the Smartlmage Of button before adjusting
Gamma.

1. Use the slider to select the desired Gamma.

Display Gamma 22

Smartimage OFf

Undo Reset

2 - Philips 22581 (£S30715000001) i X
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Calibration

Your display needs to be properly calibrated in order

for it to produce the widest range of colors accurately.

Calibration should always taka place as the fast tuning

step in the process. Remember to recalbrate any time

you make individual adjustments to image quality or

whenever you move your display to 2 new location.

. Make all other necessary adjustments to image
qualty first.

. Press Show Me to leam how to use the
«calibration tools.

. Finally, press Start to begin the calibration
process.

¥ Enable color calbration

Color software designed in collaboration with Joseph
Holmes.

Protected by U.S. Patent No. 6,686,953

Show Me Start

Quick View



. “Show Me” (Cho t6i xem) sé bat
hwéng dan hiéu chinh mau.

. Start (Bat dau) - bat dau quy trinh
canh chinh mau qua 6 budéc.

. Quick View (Xem nhanh) tai cac hinh
anh truéc/sau.

. Tr& vé giao dién chinh Color (Mau),
click nat Cancel (Huy).

Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwoc
bat. Néu khéng chon muc nay, ban
khéng duwgc phép hiéu chinh mau va
tat cac nut khéi ddong va xem nhanh.
Phai c6 théng tin bang sang ché trén
man hinh hiéu chinh.

Man hinh hiéu chinh mau dau tién:

Nut Previous (Trwdc) sé tat cho dén
khi man hinh mau th& hai bat 1én.

Next (Ké tiép) s& chuyén vao muc tiéu
tiep theo (6 muc tiéu).

Cubdi cung, vao giao dién File>Presets
(File>Cai san).

Nut Cancel (HUy) sé dong giao dién
ngwoi dung (Ul) va tré ve trang bd
sung.
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Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat déng khi chon
Preferences (Ju tién) tr menu Options
(Tuy chon) s6 xubéng. Trén man hinh
khéng hé trg twong thich véi chudn DDC/
Cl, chi c6 sén céac thé Help (Tro gitp) va
Options (Tuy chon).

B smartControl 2 - Philps 22581 (CS30715000001) (2 X

SmartControl Lite PHILIPS

Preferences

You can use the following options to configure

¥ Enable menu when right-cicking on desktop
5 ﬁ ¥ Enable task tray menu
| Preferences ¥ Run at system start-up
u Set Transparency:
Q @ 0% C 50% C 100%
d elect language:
nglis B

Adjust Audio

« Hién thj cac cai dat wu tién hién hanh.
« O vira chon sé bat tinh nang nay. O
chon la nat bat/tat.

« Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh)
hién thi cac lwa chon SmartControl
Lite cho Select Preset (Chon cai san)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (D3 tat)
sé€ xb6a SmartControl Lite khéi menu
thudc tinh click phai.

 Biéu twong Enable Task Tray (Bat

khay tac vu) dwoc chon la (Bat) theo
mé&c dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thj cac tuy chon menu
cho Help (Tr¢ giup), Technical Support
(H6 tro’ ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi da tat Enable task tray



menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thj EXIT
(THOAT).

» Theo mac dinh Run at Startup (Chay
khi kh&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé& khéng
bat khi kh&i déng hodc nam trong
khay tac vu. Cach duy nhat dé bat
SmartControl Lite |a to phim tat trén
man hinh nén hoéc tir file chwong
trinh. B4t ky bo cai dat sdn nao dé
chay khi kh&i dong sé hoat déng
khong tai khi 6 nay khéng dwoc chon
(Da tat).

« Enable transparency mode (Bat ché
do trong sudt) (Windows 7, Vista, XP).
Mac dinh 1a 0% Mo.

Options>Input (Tuy chon>Nhap) - Sé

chi hoat dong khi chon Input (Nhap) tw

menu Options (Tuy chon) s6 xudng. Trén
man hinh khéng hé tro' twong thich véi
chuan DDC/CI, chi c6 sn cac thé Help

(Tro giup) va Options (Tuy chon). Tat ca

céac thé SmartControl Lite khac déu khéng

cb san.

B SmartControl

SmartControl Lite

2 - Philps 22581 (C530715000001) {%}.%
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Input

Your display has two inputs (connections on back of

this displa can hoak up two different sources
at the sai e the Analog In and Digital In
butt source you'd lke to view. You
are curr the analog in image.
IMPORTANT! itch inputs SmartControl may

lose the ability | your monitor. In this case you

put Select button on the front

Adist ay have to u
Ao of your monit h back to the original input
| before SmartControl functionality can be restored.
)
\g Auto Pivot
TREL
Color Input
. 3 E
\@ Wizard
. B
Options Presets
\ﬁ Multi Monitors
=
Help

Analog In Digital In

« Hién thi giao dién hwéng dan Source
(Ngudn) va cai dat nguon nhap théng
tin hién hanh.

« Trén cac man hinh nhap riéng, giao
dién nay sé khang hién thi.
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Options>Audio (Tuy chon>Am thanh)
- S& chi hoat déng khi chon Audio (Am
thanh) tir menu Options (Tuy chon) sb
xudng.

Trén man hinh khéng hé trg twong thich
v&i chudn DDC/CI, chi cé san cac thé
Help (Trg giup) va Options (Tuy chon).

PHILIPS

B SmartControl
SmartControl Lite

Audio

Adjust the Volume of the integrated loudspeakers by
using the slider.

Tum off the integrated loudspeakers by checking the
Mute checkbox.

| ™ Mute

Adjust Audio
A
\g Auto Piot
.
Color Input
3 |3
Wizard
, 2
Options Prasets
\ Mutti Monitors
T Volume 100
Help = n
Undo

Help>User Manual (Tro’ giup>Sé tay st
dung) - Sé chi hoat déng khi chon User
Manual (Sé tay st dung) tr menu Help
(Tro giup) sé xubng. Trén man hinh khéng
hd tro twong thich véi chuan DDC/CI, chi
c6 san céac thé Help (Tro giup) va Options
(Tuy chon).

‘ SmartControl 2 - Philips 22581 (C530715000001) | 2) X

SmartControl Lite PHILIPS

User Manual

If you need help setting up or operating SmartControl,
click the Tech. Support button. You'l have the
option to fil out an Assistance Form.

jon about your
to the assistance

software automaticaly e a
use this feature.

] form. You'll need to be

Adjust
User Manual
2
®
Update
Color ‘.ﬂ
=
g Display ID
0
\@ System ID
Options
K5
. Version
=
Help

User Manual Tech. Support



Help>Version (Tro’ giup>Phién ban) - Sé
chi hoat déng khi chon Version (Phién
ban) tr menu Help (Tro gitp) sé xubng.
Trén man hinh khéng hé trg twong thich
v&i chudn DDC/CI, chi cé sén cac thé
Help (Tro giup) va Options (Tuy chon).

w SmartControl 2 - Philips 22581 (€530715000001) |7\ X

SmartControl Lite PHILIPS

User Manual

—=
Help

User Manual Tech. Support

Menu nhay cam v¢&i thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thuéc tinh) s& dwoc Bat. Néu
da chon Enable Context Menu (Bat thudc
tinh) trong giao dién Options>Preferences
(Tuy chon>Uu tién) thi menu nay sé hién
thi.

@ SmartControl
Select Preset 4
Tune Display

Menu Thuodc tinh ¢c6 ba muc nhap:

* SmartControl Lite - khi da chon, About
Screen (V& man hinh) sé hién thj.

 Select Preset (Chon cai dat san) -
Cung cép menu cac muc cai sin da
lwu theo trinh tw d& s dung ngay.
DAu kiém sé& hién thi muc cai sdn hién
da chon. Muc Factory Preset (Cai sdn
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goc) ciing c6 thé dwoc chon tir menu
sO xuong.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

« Smartimage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuan), Internet,
Game.

Pa bat menu khay tac vu
Ban c6 thé hién thi menu khay tac vu
bang cach click phai vao biéu twong
SmartControl Lite tir khay tac vu. Click trai
sé bat rng dung.
Help
Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

* Help (Trg giup) - Truy cap file User
Manual (Sé tay st dung): M& file User
Manual (Sé tay st dung) qua ctra s
trinh duyét mac dinh.

«  Technical Support (H6 tro’ ki thuat) -
hién thi trang hd tro k§ thuat.

« Check for Update (Kiém tra cap nhat)
- d&n nguwoi dung dén Nén (rng dung
PDI va kiém tra phién ban cta ngudi
dung so v&i phién ban cé sdn maoi
nhéat.

« About (V&) - Hién thj théng tin tham
khao chi tiét: phién ban san pham,
thdng tin vé phién ban va tén san
pham.

« Exit (Thoat) - Péng SmartControl Lite.

Pé chay lai SmartControl Lite, hay chon
SmartControl Lite ttv menu Program
(Chwong trinh), click déi biéu twong PC
trén man hinh nén hodc khdi dong lai hé
théng.



PHILIPS

SmartControl

EmaritControl
\ersion 3.20
chune-standard-R2007-01-04-1151-23
Copryright 1993-2007 Portrait Displaye, Inc.
Patents Pending

Da tat menu khay tac vu

Khi da tat Khay tac vu trong thw muc

wu tién, chi con cé san Iwa chon EXIT
(THOAT). Bé x6a hoan toan SmartControl
Lite khoi khay tac vu, hay tat Run at
Startup (Chay khi kh&i dong) trong
Options>Preferences (Tuy chon>Uu tién).

6quy

Téat ca cac hinh minh hoa trong phan
nay chi dwoc dung dé tham khao. Ching
t6i cé thé thay dbi phién ban phdn mém
SmartControl ma khéng can théng bao
trwde. Vui long ludn truy cap trang web
chinh thirc cua Portrait tai www.portrait.
com/dtune/phl/enu/index dé tai vé phién
ban phan mém SmartControl m&i nhét.
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4. Cac thong so ky thuat

Loai mat man hinh TFT-LCD

DPén nén LED

C®& man hinh Réng 23 inch (58,4cm)
Hé sb co 16:9

D6 pixel 0,265 x 0,265 mm

D6 sang 250 cd/m?

Do twong phan thong minh 10,000,000:1

Do twong phan (chuén) 1000: 1

Thoi gian dap ng (chuén) 12ms(GtG)

D6 phan giai toi wu

1920 x 1080 @ 60Hz

Go6c xem

178° (H) / 178° (V) @ C/R > 10

Mau man hinh

16,7 triéu mau

Dau vao tin hiéu

Tbc d6 phat doc 56Hz - 76Hz
Tan sb ngang 30kHz - 83kHz
sRGB (P&-Luc-Lam chuan) | CO

233V5QSBP, 233V5QABP: VGA (Analog),DVI
(KTS,HDCP) (c6 san cho cac mau vira chon)
233V5QHABP: VGA (Analog),HDMI (KTS,HDCP)

DAu ra/vao am thanh

233V5QABP, 233V5QHABP:: Dau vao am thanh PC,
d4u ra tai nghe

Tin hiéu vao
Tién ich

Tién ich cho ngwoi dung

DPdng bd riéng, Bdng bd véi tin hiéu xanh luc

233V5QSBP:

AUTO/VY  [O0/A 0-/ 4 /0K Q)
233V5QABP, 233V5QHABP::

AUTO/ W (/A 0-/ <4 /0K )

Ngén ngir OSD (Hién thi trén
man hinh)

Tiéng Anh, Tiéng Dtrc, Tiéng Tay Ban Nha, Tiéng Phap,
Tiéng Y, Tiéng Hungary, Tiéng Ha Lan, Tiéng B6 Dao
Nha, Tiéng B6 Dao Nha Brazil, Tiéng Ba Lan, Tiéng
Nga, Tiéng Thuy Dién, Tiéng Phan Lan, Tiéng Thé Nhi
Ky, Tiéng Séc, Tiéng Ukrana, Tiéng Hoa gian thé, Tiéng
Nhat, Tiéng Han, Tiéng Hy Lap, Tiéng Hoa phén thé

Tién ich khac

Khoa Kensington

Twong thich vé&i chuan Plug
& Play (C&m vao la phat)

DDC/CI, sRGB, Windows 7/Windows 8/Vista/XP, Mac
OSX, Linux

L&p VESA

100x100 mm

-5/+20

Nghiéng
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233V5QABP:

Ché d6 bat 26,3W (chuan), 29,61W (tbi da)
Ché do ngli (cho) 0,5W
Tat 0,5W
DPén bao LED nguén Ché d6 bat: Ché dd Trang, Chd/Ngu: Trang (nhap nhay)
Bo ngudn Thir néng, 100-240VAC, 50-60Hz
233V5QSBP:

26,23W (chuéan), 26,96W (tbi da)

Ché d6 bat or 25.67 W (chuén), 26.21W (tbi da) (for Analog only
model)
Ché d6 ngu (cho) 0,5W
Tat 0,5W
DPén bao LED nguén Ché d6 bat: Ché d6 Trang, Ch/Ngl: Tréng (nhap nhay)
Bo ngudn Thir néng, 100-240VAC, 50-60Hz
233V5QHABP::
Ché d6 bat 25,14W (chuén), 30,97W (tbi da)
Ché do6 ngu (chd) 0,5W
Tat 0,3W
DPén bao LED nguén Ché d6 bat: Ché dd Trang, Cho/Ngu: Trang (nhap nhay)
B6 ngudn Thir néng, 100-240VAC, 50-60Hz

San pham kém theo dé gitr
(Réng x cao x day)

547 x 416 x 219 mm

San pham khong kém theo
dé gilr (Rdng x cao x day)
Trong lwong

547 x 340 x 53 mm

San pham kém theo dé gitv | 3,82kg
S?n _eham khéng kém theo 3.4kg
dé qgilr

Sén pham déng goi 5,25kg

Diéu kién hoat déng

binh gitra cac sw cb)

Pham vi nhiét d6 (hoat déng) | 0 °C -40 °C
Pham YI nhiét dé (Khéng 220 °C - 60 °C
hoat dong)

D6 4m twong doi 20% - 80%
MTBF (Thoi lwong trung 30.000 gi&
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Chi thi ROHS (Gi¢i han cac

chét gay hai) =
EPEAT Bac (www.epeat.net)
Thung dwng C6 thé tai ché 100%
Energy Star co

Tuan tha va tiéu chuin

CE Mark, FCC Class B, CU, SEMKO, BSMI, ETL,

Phé chuan theo quy dinh 1ISO9241-307, TCO Certified, SASO, EPA, CB, PSB,
KUCAS
Mau Pen den
L&p son ngoai Hoa van
& Ghichu

1. Vang hay bac EPEAT chi ¢6 hiéu lwc tai noi ma Philips da dang ky san pham. Hay truy
cap www.epeat.net dé biét tnh trang dang kw tai qudc gia ctia ban.

N

D@ liéu nay chiu sw thay ddi ma khéng can théng bao truéc. Truy cap www.philips.com/
support dé tai vé phién ban t& roi méi nhéat.
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4.1 Ché do do6 phan giai & cai
dat san

z
R

E! D6 phan giai téi da
1920 x 1080 @ 60 Hz (dau vao analog)
1920 x 1080 @ 60 Hz (dau vao KTS)

E1 Do phan giai khuyén dung
1920 x 1080 @ 60 Hz (dau vao KTS)

Tansbd Do phangidi Tan sb doc

ngang (kHz) (Hz)
31,47 720 x 400 70,09

31,47 640 x 480 59,94

35,00 640 x 480 66,67

37,86 640 x 480 72,81

37,50 640 x 480 75,00

37,88 800 x 600 60,32

46,88 800 x 600 75,00

48,36 1024 x 768 60,00

60,02 1024 x 768 75,03

4477 | 1280x720 | 59,86

63,89 1280 x 1024 60,02

79,98 1280 x 1024 75,03

55,94 1440 x 900 59,89

70,64 1440 x 900 74,98

65,29 1680 x 1050 59,95

67,50 1920 x 1080 60,00

& Ghi chu

Lwu y rdng man hinh cta ban hoat déng
tét nhat & d6 phan giai gbc 1920 x 1080
@ 60Hz. D& c6 chét lwong hién thj tét
nhat, hay dung dé phan giai khuyén nghi
nay.
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5. Quan ly nguon dién Pinh nghfa quén ly ngudn dién

£ . s A Tré
Néu ban da cai dit card man hinh hay Cé 0| TaT | Kneng | Knong | 05w (chué) | (Nnp
phan mém twong thich chudn VESA DPM nhay)
vao PC, man hinh c6 thé ty déng giam Tat | TAT | - - |05W (chuén) | TAT
tiéu thu dién khi khéng s&r dung. Néu phat
hién nhap tr ban phim, chudt hay thiét bi
nhap khac, man hinh sé “hoat déng” tw Cai dat sau day duwgc dung dé do murc
dong. Bang sau day sé hién thi mirc tiéu tiéu thu dién trén man hinh.
thu dién va cach truyén tin hiéu cua tinh DO phan giai gbc: 1920 x 1080
nang tiét kiem dién tw déng nay: . .
g i 2N 1 dong nay » Do twong phan: 50%
233V5QABP: « P06 sang: 250 nit
Binh nghia quan ly nguon dién « Nhiét d6 mau: 6500k v&i kiéu mau
Ch8 6 |,y [PONg bO| Béng | Ngudn dien | Mau dén trang day du
VESA ngang | b6 doc str dung LED
26,3 W & Ghichu
Hoatdong| BAT | Co | Co | ,qgrwinai| T8n9 D@ liéu nay chiu su thay ddi ma khéng
da) can théng bao trwérce.
£ <n Trang
Ché dO % A a z £
ngil (chts) TAT | Khong | Khong [0,5W (chuan) %l}l}t:}ag
Tat TAT - - |0,5W (chudn)| TAT
233V5QHABP::
Dinh nghia quan ly ngudn dién
Ché dd Video Ddng bo| Bdng | Ngudn dién | Mau dén
VESA ngang | b6 doc st dung LED
25,14;W
Hoatdong| BAT | co | co 3o(g;u\?vn()t6i Tréng
da)
Chéds | - A A , .| Tréng
ngii (chts) TAT | Khong | Khong [0,5W (chuan) %l}l}t:}a/;;
Tat TAT - - |0,3W (chudn)| TAT
233V5QSBP:

Dinh nghia quan ly ngudn dién

Ché do
VESA ngang | bo doc st dung LED

Video bong bo| Bong | Nguon dién | Mau den

26,23 W
(chudn)
26,96 W (tdi
da)
Hoat dong| BAT Co Co or 25.67 Trang
W (chuén),
26.21W (t6i
da) (for Analog
only model)
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6. Théng tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is designed for both you and the
planet!

TCO Development works for
sustainable T - manufacture,
use and recycling of IT products

reflecting environmental, social and economic
responsibility.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:

*  Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

*  Products are tested according to rigorous
safety standards at impartial laboratories

*  Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO
Certified Displays:

*  Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

* Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of IT equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and ICT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)

User define mode is used for TCO Certified
compliance.




EPEAT

(www.epeat.net)

\ The EPEAT (Electronic
’, Q?' Product Environmental
("))

Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on 51

environmental criteria developed through

an extensive stakeholder consensus process

supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

«  EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

* EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

«  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

«  EN50581:2012 (Technical documentation
for the assessment of electrical and
electronic products with respect to the
restriction of hazardous substances)

*  EN 50564:2011 (Electrical and electronic
household and office equipment —
Measurement of low power consumption)
following provisions of directives applicable

*  2006/95/EC (Low Voltage Directive).
« 2004/108/EC (EMC Directive).

«  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1ISO9000
level.

*  2011/65/EU (RoHS Directive) and is
produced by a manufacturing organization
on 1ISO9000 level

The product also comply with the following
standards

*  1509241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

+ TCO CERTIFED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystargov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

HC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de
I'article 15 Des régles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences



nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic
Only)

Thiz device belongs to category B devices as described in EM 55022, unless it is spacifi-
cally stated that it is a Class A devics on the spacification labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 matars). The ussr of the
device is obliged to take all staps necessary to remove sources of intarfarence io tals-
communication or ofher devices.

Pokud nani na typowem Btithu poditade uvedano, = spadi do do fidy A podle BN 55022,
spadd aviomaticky do tfidy B podle EN 55022, Pro zafizen| zefazend do tfidy A (chranné
pésma 30m) podie EN 55022 platl nésledujicl. Dojde-l k ruliani talsknmunikatnich nebo
Pnych zafizeni je ufvatel povinnen provést takovd opatfgni, aby meSani odstranil.

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer; and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107/
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Uregdzende powinno byé zasilane x priaads 2 preybgezsonym obwodem ochronmym (gniazdo
kotkiensy. Wapdlpracuggce ze soby uresdeenta (kommputer, monstor, drubrka) powiany byd sasilane
# Lo shmepn drddla.

Instalacja elektrycma pomicsacsenia powinna mwierad w preewaodce Browym reserawows achrong
proed rwarciami, w postaci beepiecenika o wartedcl smamionowe] mie wigkszej ni 16A (amperiw).
Wooalu catkowitign wybpernenis uregdeents 2 siect zasilania, naledy wyinl wiveeky kabla
easilajeego = griazdka, kodre powinno anajdowad sig w poblizu ursdeenda @ bvd Barws dostgpie.

Anak berpieeeefarwa "B” potwiendza zpodaodd urssdrena @ wymapandami beepleceefsiwa
whytkowanma zawartyml w FR-SLTAI107 1 PN-REAGZE].

Pozostale instrukcje begpieczensiwa

* Mie maledy whywad wiyceek adapierowvch lub wuwad kedka obwedw ochrommego = wiyceki.
Jedel komsoiene jesl iky e prasdluiaczs o naledy whyd praodlusacs 3-rvlowega 2
prrawidlowa potscronymm praewoden ochmonnymn.

Sysbem kompulerowy maleiy saberpiccryd proed naghyme, chowilowymi wenostama fub spad-
kami napgcia, uiyw limimatars prespeed, uresdzenio dopasowajicego luh
berakiocemowega zaslania

* Maledy upewnil sig. ab
byly witletaczone w it

i i Lekalo ng kablech sysiemu komputerowego. araz aby kabde ne

g, gdese mmodkna byloby na mie nadepliwal lub potyked sig o me.

* Mie maledy roclewad napogio an meych plyndo e system kompuierowy.

*  Nie nalery wpychal Fadnyeh preedmictow do abwoendw systemmu kemputervwega, givi moie
1o spowodowad pedar lub poradenie prydem, popree: rwarcie chemenida wenngtrznych

* System kompaterowy powinden enapdowad sig 2 dala od greejnikiw o drédel clepla. Poradro,
mie maleey blokawad atworaw wentylacyjnych. Mabeidy unzkac kladeenza luinych papserdw posd
kamputer oz umiesrczania kampubera w clasaym migjscw bes madliwasc cyrkulacji powi-
elrra wokal nicge.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
MElHEMEmIITE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schidden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Geréates befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
Il @ 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit |hr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 7/0dB (A) oder
weniger.

7N ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.



6. Thong tin quy dinh
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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* ' BRI RISED RIS SRR MR R - MR R AR SRBS
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X RTEAEA BN R E ORI RS R S Y
(A TFEEFRFAEAEIRNRRERGE) NENERER  BRERFIT "X B4
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RIBFREAR: (BERSERINAEENE) | AEREHEUTEK
BERRER(cd/W) > 1.05
KIARSEAE (W) | < 0.5

BEER 1%

BESUIE GB 21520-2008

FEMEXEERERPERSWTRR © http://www.energylabel.gov.cn/
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EU Energy Label

r- m I ]1
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]

PHILIPS .o

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

& Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.

E-Waste Declaration for India

This symbol on the product or on its packaging
indicates that this product must not be
disposed of with your other household waste.
Instead it is your responsibility to dispose of
your waste equipment by handing it over to

a designated collection point for the recycling
of waste electrical and electronic equipment .



The separate collection and recycling of your
waste equipment at the time of disposal will
help to conserve natural resources and ensure
that it is recycled in a manner that protects
human health and the environment. For more
information about where you can drop off your
waste equipment for recycling in India please
visit the below web link.

http://www.india.philips.com/about/sustainability/
recycling/index.page.

Information for U.K. only

WARNING - THIS APPLIANCE MUST BE
EARTHED.

Important:

This apparatus is supplied with an approved
moulded 13A plug. To change a fuse in this type
of plug proceed as follows:

1. Remove fuse cover and fuse.

2. Fit new fuse which should be a BS 1362
S5AAS.TA. or BSI approved type.

3. Retit the fuse cover.

If the fitted plug is not suitable for your socket
outlets, it should be cut off and an appropriate
3-pin plug fitted in its place.

If the mains plug contains a fuse, this should
have a value of 5A.If a plug without a fuse is
used, the fuse at the distribution board should
not be greater than 5A.

NOTE: The severed plug must be destroyed
to avoid a possible shock hazard
should it be inserted into a 13A socket
elsewhere.
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How to connect a plug

The wires in the mains lead are coloured in
accordance with the following code:

BLUE -“NEUTRAL"(*N")
BROWN -“LIVE"("L")
GREEN&YELLOW -“EARTH"("E")

1. The GREEN&YELLOW wire must be
connected to the terminal in the plug
which is marked with the letter "E" or by
the Earth symbol or coloured GREEN or
GREEN&YELLOWV.

2. The BLUE wire must be connected to the
terminal which is marked with the letter
"N" or coloured BLACK.

3. The BROWN wire must be connected
to the terminal which is marked with the
letter "L" or coloured RED.

Before replacing the plug cover, make certain
that the cord grip is clamped over the sheath of
the lead - not simply over the three wires.




7. Dich vu cham sé6c
khach hang va bao
hanh

7.1 Chinh sach 16i diem anh
man hinh phéng cua Philips
Philips cb gang cung clp cac san pham
chét lwong cao nhét. Chung t6i ap dung
mot s6 quy trinh san xuét tién tién nhét
trong Iinh vie va thwe hién quy trinh kiém
tra chat lwong nghiém ngat. Tuy nhién, cac
16i diém anh hay diém anh con trén man
hinh TFT dung trong cac man hinh phang
ddi khi khdng thé tranh khaéi. Khéng nha
san xuét nao cé thé ddm bao rang moi man
hinh sé khong c6 cac 16i diém anh, nhung
Philips dam bao rang bat ky man hinh nao
c6 mét so 16i khdng thé chap nhan sé dwoc
stra chira hoac thay méi dwa vao chinh
sach bao hanh. Théng bao nay giai thich
nhirng kiéu I16i diém anh khac nhau va dinh
nghta cac mirc 16i co thé chap nhan cho
moi kiéu 16i. D& hwéng dich vu stra chiva
hay thay thé theo chinh sach bdo hanh, sb
lwong 16i diém anh trén man hinh TFT phai
vwot qua cac mirc chap nhan nay. Vi du,
khéng qua 0,0004% diém anh con trén man
hinh c6 thé bi 16i. Ngoai ra, Philips tham
con dat ra cac tiéu chuén chat lwong cao
hon cho mét sé kiéu hay két hop 16i diém
anh vén dé& nhin thay hon céac kiéu 16i khac.
Chinh sach nay c6 hiéu lyc trén toan cau.

(" didm diém  diém )
anh phu anh phu anh phu

RGBS
dlem

anh

Dlem anh va diém anh con

Diém anh hay phan t&r &nh gdm ba diém
anh con trong cac mau chinh dé, luc va
lam. Nhiéu diém anh cuing tao thanh hinh
anh. Khi moi diém anh con ctia mét diém
anh sang lén, ba diém anh con c6 mau séc
cung hién thi nhw mot diém anh trang don
1&. Khi moi diém anh con t6i mo, ba diém
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anh con c6 mau sac ciing hién thj nhu mét
diém anh den don lé. Nhiing két hop diém
anh con sang va téi khac hién thi nhw cac
diém &nh don 1& tir nhirng mau khac.

Cac kiéu 16i diém anh

Céc 16i diém anh va diém anh con hién thi
trén man hinh theo nhirng cach khac nhau.
C6 hai kiéu 16i diém anh va nhiéu 16i diém
anh con trong méi kiéu 16i.

Cac 16i cham sang

Cac 16i chdm sang hién thi dwoi dang cac
diém anh hay diém anh con vén ludn sang
hay “bat”. Nghia 1a méi chdm sang 1a mot
diém anh con vén ndi 1&n trén man hinh khi
man hinh hién thj kiéu hinh t6i mo. C6 céac
kiéu 16i chAm sang.

- A

- %

Mét diém anh con sang dd, luc hay lam.

/ N

I C

N Y
Hai diém anh con sang gan nhau:

- Bbé+Lam=Tim

- Do + Luc =Vang

- Luc + Lam = Luc lam (Lam nhat)
s ™




Ba diém anh con sang gan nhau (mét diém
anh trang).

& Ghi chu

Chém sang dd hay lam phai sang hon
50% so v&i cac chdm xung quanh trong
khi chdm sang luc sang hon 30% so v&i
cac chdm xung quanh.

Cac 16i cham den

Céac 16i chAm den hién thi dwéi dang cac
diém anh hay diém anh con vén luén téi
mo hay “tat”. Nghta la méi cham tdi mo
la mot diém anh con vén ndi lén trén man
hinh khi man hinh hién thj kiéu hinh sang.
C6 cac kiéu 16i chadm den.

4 N

a I N

D6 gan cua cac 16i diém anh

Vi cac 16i diém anh va diém anh con cua
cung kiéu 16i von gan v&i mot kiéu 16i khac
co thé dé nhin thay hon, Philips cling néu
ré cac dung sai vé dé gan cua I6i diem anh

4 N

a N
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Dung sai 16i diém anh

DPé hwéng dich vu stra chiva hay thay

thé do céac 16i diém anh trong thei han

bao hanh, man hinh TFT trong man hinh
phéng Philips phai c6 cac 16i diém anh hay
diém anh con vwot qua nhirvng dung sai
néu trong cac bang sau.

\ %
LOI CHAM SANG MU’C CHAP NHAN
1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (mét diém anh trang) 0
Khoang cach gitra hai 16i chdm sang* >15mm
Tbng sb 16i chAm sang ctia moi kiéu 16i 3

LOI CHAM DPEN

1 diém anh con t6i mo

MUC CHAP NHAN
5 hoac it hon

2 diém anh con t6i m& gan nhau

2 hoac it hon

3 diém anh con t6i m& gan nhau

0

Khoang cach gitra hai 16i chAm den*

>15mm

Tbng sb 16i chAm den ctia moi kiéu 16i

5 hoac it hon

TONG SO LOI CHAM

MU’C CHAP NHAN

Tbng sb 16i chAm sang hay den ctia moi kiéu 16i

5 hoac it hon

& Ghichu

1. 1 hay 2 16i diém anh con gan nhau = 1 16i chdm

2. Man hinh nay tuan thi chuan 1S09241-307. (1IS09241-307: Yéu cau, phan tich vé hiéu
nang va cac phwong phap kiém tra tuan tha cho man hinh dién tt)

3. 1S09241-307 la tiéu chuan tiép theo clia tiéu chudn 1SO13406 ci, von da bi hty bd bdi
T chirc Tiéu chudn hoa Quéc té (ISO) vao ngay: 13-11-2008.



7.2 Cham séc khach hang & Ché ddé bao hanh

Dé c6 théng tin chi tiét vé chinh sach bao hanh va yéu cau hd tro thém dwoc ap dung cho
khu vire cta ban, vui long truy cap website www.philips.com/support. Ban ciling c6 the lién

hé v&i Trung tdm cham soc khach hang dia phwong ca Philips theo sb dién thoai dui

day.

Théng tin lién lac cho khu vwec TAY AU:

Quéc gia

S6 BT dwong day
néng

Gia

Gi® hoat déng

Austria RTS +43 0810 000206 € 0.07 Mon to Fri:9am - 6pm
Belgium Ecare +32 078 250851 €006 Mon to Fri:9am - 6pm
Cyprus Alman 800 92 256 Free of charge |Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff | Mon to Fri:9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri:9am - 6pm
Germany RTS +49 01803 386 853 | € 0.09 Mon to Fri:9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge |Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri:8am - 5pm
Italy Anovo ltaly +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff |Mon to Fri:9am - épm
Netherlands Ecare +31 0900 0400 063 | € 0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri:9am - épm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri:9am - 6pm
Portugal Mainteq 800 780 902 Free of charge |Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €010 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri:9am - 6pm
Switzerland ANOVO CH | +41 02 2310 2116 Local call tariff | Mon to Fri:9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri: 8am - 5pm

Théng tin lién lac cho khu viec CHAU MY LATINH:

Quéc gia Trung tam dich vu S6 cham séc khach hang
Brazil 0800-7254101

: Vermont
Argentina 0800 3330 856

Théng tin lién lac & Trung Quéc:

S6 cham séc khach hang
4008 800 008

Quéc gia
China

Trung tam dich vu
PCCW Limited
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Théng tin lién lac cho khu viec TRUNG VA PONG AU:

Quéc gia

Trung tam
dich vu

S6 cham séc khach hang

+37517 217 3386
Belarus N/A IBA +37517 217 3389
Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport 420 272 188 300

+372 6519900(General)
Estonia N/A FUJITSU +372 6519972 (workshop)
Georgia N/A Esabi +995 322 91 34 71

+36 1 814 8080(General)
Hungary N/A Profi Service +36 1814 8565(For AOC&Philips only)
Kazakhstan N/A Classic Service Ll.c. |+7 727 3097515

+371 67460399
Latvia N/A ServiceNet LV +371 27260399

+370 37 400160(general)
Lithuania N/A UAB Servicenet +370 7400088 (for Philips)
Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus | N/A ServiceBy +37517 284 0203
Turkey N/A Tecpro +90 212 444 4 832
Ukraine N/A Topaz +38044 525 64 95
Ukraine N/A Comel +380 5627444225

Théng tin lién lac cho khu viec NAM MY:

Quéc gia  Trung tam dich vu S6 cham séc khach hang
US.A. EPl-e-center (877) 835-1838
Canada EPl-e-center (800)479-6696
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Théng tin lién lac cho khu virc Chau A TBD/Trung Pong/Chau Phi (APMEA):

S6 cham séc khach

Quoc gia hang Gio hoat dong
Armenia
Azerbaijan _
Georgia Firebird service centre +97 14 8837911 ?g%OThu' 09:00 -
Kyrgyzstan '
Tajikistan
Australia AGOS NETWORK PTY LTD 1300 360 386 ?ggp::” 700am-
Hong Kong: o i
Hong Kong | Company: Smart Pixels Technology | Tel: +852 2619 9639 Mon.~Fri. 9:00am
6:00pm
Macau Ltd. Macau: Sat 9:00am-1:00Bm
Tel: (853)-0800-987 - EP
: Tel: 1 800 425 6396 Mon.~Fri. 9:00am-
India REDINGTON INDIA LTD SMS: PHILIPS to 56677 | 5:30pm
+62-21-4080-9086 Mon.~Thu. 08:30-
Indonesia PT. CORMIC SERVISINDO (Customer Hotline) 12:00; 13:00-17:30
PERKASA +62-8888-01-9086 Fri. 08:30-11:30;
(Customer Hotline) 13:00-17:30
Israel Fastronics LTD 1-800-567000 >un—Thu. 08:00-
18:00
Mon.~Fri. 9:00am-
Korea Alphascan Displays, Inc 1661-5003 5:30pm
Sat. 9:00am-1:00pm
Mon.~Fri. 8:15am-
Malaysia R-Logic Sdn Bhd +603 5102 3336 5:00pm

Sat. 8:30am-12:30am

New Zealand

Visual Group Ltd.

0800 657447

Mon.~Fri. 8:30am-

5:30pm
Pakistan TVONICS Pakistan +92-213-6030100 oun.~ Thu. 10:00am-
6:00pm
o EA Global Supply Chain Solutions _ Mon.~Fri.
Philippines Inc. (02) 655-7777; 6359456 R e
G e " Mon.~Fri. 9:00am-
Singapore E@iiir?gfag;r;e(iitfg (Philips (65) 6882 3966 6:00pm
Sat. 9:00am-1:00pm
South Africa | Computer Repair Technologi 011 262 3586 Hon.= Fri.
ou rica omputer Repair Technologies 08:00am~05:00pm
Taiwan FETEC.CO 0800-231-099 on.=Fri. 09:00 -
18:00
Thailand Axis Computer System Co.,, Ltd. (662) 934-5498 Mon.=Fri

08:30am~05:30pm
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7. Dich vu cham séc khach hang va bao hanh
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8. Khac phuc sw co &
Hoi DPap

8.1 Khac phuc sw cb

Trang nay gidi quyét cac s cb vdn nguoi
dung co thé khac phuc. Néu sy ¢cb van
tiép dién sau khi ban da tht» dung céac giai
phap trén trang nay, hay lién hé voi dai
dién dich vu khach hang cuta Philips.

Bl Ccac sw c6 thwong gap

Khéng cé hinh anh (Pén LED nguén

khong sang)

E)am bdo da cdm day ngudn vao 6
cam dién va mat sau cdia man hinh.

*  Truwdc tién, ddm bao nat nguon &
mat triéc man hinh nam & vi tri OFF
(TAT), sau d6 day nut sang vi tri ON
(BAT).

Khéng cé hinh anh (Pén LED nguén

sang trang)

Dam bao da bat may tinh.

«  Pam bao cap tin hiéu da dwoc két nbi
dung cach v&i may tinh clia ban.

. Dém béo cap man hinh khéng co cac
ch,éu cam bi cong trén mat két noi.
Néu co, hay stra hay thay méi cap.

« Co thé da bat tinh nang Tiét kiém
nang luvong

Man hinh théng bao

Attention

Check cable connection

«  Dam bao cap man hinh da duoc két
ndi dung cach v&i may tinh cua ban.
(Ciing tham khao Hwdng dan khéi
ddng nhanh).

« Kiém tra xem cap man hinh c6 cac
chau c&m bi cong hay khong.

* Dam bao da bat may tinh.
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Nut AUTO (Tw dong) khéng hoat déng
Chtrc ndng tw ddng chi ap dung & ché
dd VGA- Analog. Néu khong hai long
véi két qua, ban co6 thé thuc hién cac
diéu chinh tha céng qua menu OSD
(hién thi trén man hinh).

& Ghi chu
Chtrc nang Auto (Tw déng) khong ap dung
& ché dd DVI-KTS vi n6 khéng can thiét.

Cac dau hiéu vé khoi hay tia Itra c6 thé

nhin thay ] ]

* Khong thwe hién bat ky buéc khac
phuc sw cb nao

« Ngat ngay két ndi man hinh khoi 6
cam dién chinh cho an toan

* Lién hé ngay v&i dai dién dich vu
khach hang cua Philips.

Bl Cac sw c6 hinh anh

Hinh anh khéng nam giira tam man

hinh

» Chinh vij tri hinh anh qua chirc nang
“Auto (Tw ddng)” trong cac nut diéu
khién chinh trén menu OSD.

« Chinh vi tri hinh anh qua Phase/Clock
(Goc pha/Pdng ho) cta Setup (Cai
d&t) trong cac nut diéu khién chinh
trén menu OSD. N6 chi ¢6 hiéu lwc &
ché do VGA.

Hinh anh rung Ién trén man hinh

« Kiém tra xem cap tin hiéu da dwoc
cém chat dung cach vao bang mach
dd hoa hay may tinh hay chua.

Hién thj hién twong chap chén doc

*  Chinh hinh anh qua chtrc nang “Auto
(Tw d6ng)” trong cac nut diéu khién
chinh cia menu OSD.



* Loai bd cac vach doc qua Phase/
Clock (Goc pha/Bdng hd) ciia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi c6 hiéu
lwc & ché d6 VGA.

Hién thj hién twong chap chon ngang

=

W)

*  Chinh hinh &nh qua chtrc nang “Auto
(Tw doéng)” trong cac nut diéu khién
chinh cia menu OSD.

* Loai bd cac vach doc qua Phase/
Clock (Goc pha/Bdng hd) cuia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi c6 hiéu
lwc & ché d6 VGA.

Hinh anh hién thj nhoe, khéng ré hoac

qua mo

* Chinh d6 twong phan va dd sang trén
menu Hién thi trén man hinh (OSD).

Hién twong “anh ao”, “anh thir néng”
hay “anh béng ma” van hién thj sau khi
da tat nguon.

« Hién thi lién tuc cac anh tinh trong mét
thdi gian dai co thé gay ra hién twong
“anh thtr néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thir néng”, “Anh a0”
hay “Anh bong ma” 1a hién twong phd
bién trong céng nghé man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh th&r ndng” hoac “anh ao”
hay “anh bong ma” sé& dan dan bién
mat sau mot thdi gian man hinh bj
ngat dién.

e Ludn bat trinh bao vé man hinh
chuyén déng khi ban khéng st dung
man hinh.

* Ludn bat irng dung lam md&i man hinh
dinh ky, néu khéng, man hinh LCD
clia ban sé& hién thi nhirng ndi dung
tinh khéng thay dbi.
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» Cac hién twgng “anh thtr néng” hay
“anh ao” hay “anh béng ma” sé khéng
biét mat va ban can mang man hinh
di stra. Thiét hai nhw trén khéng nam
trong chinh sach bao hanh cua ching
toi.

Hinh hién thj bién dang. Van ban bi m&

hoac nhoe.

« Cai dd phan giai man hinh may tinh
sang cung ché do voi dd phan giai
man hinh gbc khuyé&n dung ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thi trén man hinh

« Cac chdm con lai 1a dac tinh théng
thwéng ciia man hinh tinh thé 16ng
dung trong cdng nghé ngay nay. Vui
long tham khao chinh sach diém anh
dé biét thém théng tin.

DPén “bat nguon” qua sang va gay choéi

mat

« Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED nguén trong cac nut
diéu khién chinh clia menu OSD.

DPé duoc tro gilp thém, hay xem danh
sach Trung tdm théng tin khach hang
va lién hé v&i dai dién dich vu cham sbc
khach hang cua Philips.



8.2 Héi bap chung
H1: Khi cai cai dat man hinh, téi can
lam gi néu man hinh hién thi
“Cannot display this video mode”
(Khéng thé hién thi ché d6 video
nay)?

Dap: b6 phan giai khuyén dung cho man

hinh nay la: 1920 x 1080 @60 Hz.

« Ngat tit ca cac cap roi két néi PC voi
man hinh ma ban da dung trwéc do.

* Trong Windows Start Menu (Menu
khéi dong Windows), chon Settings/
Control Panel (Cai d&t/bang diéu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
co6 tén “desktop area (vung man hinh
nén)’, chuyén thanh trwot sang mac
1920 x 1080 pixels.

« M¢& thé “Advanced Properties” (Thudc
tinh ndng cao) va cai Mc cap nhat
(Refresh Rate) sang 60Hz réi click
OK.

» Khéi dong lai may tinh va lap lai buwéc
2 va 3 dé kiém tra xem PC cla ban da
dwoc cai sang mue 1920 x 1080 @60
Hz hay chua.

« Tat may tinh, ngét két ndi man hinh
cii va két néi lai man hinh LCD Philips
cla ban.

« Tat man hinh réi bat lai PC.

H2: Mcrc cap nhat khuyén dung cho
man hinh LCD la bao nhiéu?

Mcrc cap nhat khuyén dung cho man
hinh LCD 1a 60Hz. Néu c6 bét cr
hién twong nhiéu ndo trén man hinh,
ban cé thé cai dat mirc nay sang
75Hz dé kiém tra xem mirc m&i nay
c6 loai bé dwoc hién twong nhiéu
hay khong.

Dap:
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H3: Cac file .inf va .icm trén dia CD
la gi? Lam thé nao dé cai dat cac
driver (.inf va .icm)?

Dap: Day la cac file driver cho man hinh
clia ban. Thuc hién theo cac chi dan
trong sb tay st dung dé cai dat cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) hodc 1ap dia driver khi ban
cai dat man hinh Ian dau. Thwe hién
theo cac chi dan dé 1ap (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat tw dong.

H4.:
DPap:

Lam thé nao dé chinh dé phan giai?
Card video/driver d6 hoa ctia ban

va man hinh sé ciing quyét dinh

cac do phan gidi co6 sén. Ban co thé
chon dé phan gidi mong mubdn trong
Control Panel (Bang diéu khién)

clia Windows® qua thé “Display
properties” (Thudc tinh man hinh).

H5: Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nut OK rdi chon
“Reset” (Cai dét lai) d& phuc héi moi
cai dat méc dinh gbc.

Dap:

H6: Man hinh LCD c6 kha ndng chéng
tray xwéc?

N6i chung ban khéng nén dé bé mat
man hinh va cham qua murc véi cac
vat khac hay va bao vé né khéi cac
vat dung sac hay cun. Khi cdm man
hinh, dam bao khéng dung strc ép
hay lwc manh Ién phia bé mat man
hinh. Diéu nay c6 thé anh huwdng
dén cac diéu kién bao hanh cta ban.

Dap:

T6i nén lau man hinh LCD nhw thé
nao?

Pap: Dé lau théng thwdng, hay st dung
khan sach va mém. Dé lau k¥, hay
dung cén isopropyl. Khéng dung
cac dung méi khac nhu coén étylic,
ethanol, axeton, hexan, v.v...

H7:



H8:

Dap:

Toi c6 thé thay déi cai dit mau
sac cho man hinh?

D7 nhién, ban c6 thé thay ddi cai
dat mau sac qua nut diéu khién trén
menu OSD theo cac quy trinh sau,
Nhén “OK” dé hién thi menu OSD
(Hién thij trén man hinh)

Nhén “Down Arrow” (Mi tén
xudng) dé chon tuy chon “Color”
(Mau) r6i nhan “OK” dé vao cai dat
mau; c6 ba lwa chon mau nhw sau.

. Color Temperature (Nhiét d6 mau);

Hai cai dat gdm 6500K va 9300K.
V&i cac cai dat trong pham vi
6500K, man hinh sé& hién thj “néng
v&i tin hiéu mau dd-trang", trong khi
nhiét d6 9300K tao ra “mat vaoi tin
hiéu mau lam-trang”.

sRGB (P&-Luc-Lam chuén); day

la cai dat chuan dé dam bao trao
d6i mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

User Define (Tw chon); ngudi dung
c6 thé ty chon cai dat mau sac wu
tién bang cach chinh mau d, luc va
lam.

& Ghi chu

Do mau anh sang tda ra ttr mét vat dung
trong khi né dwoc lam nong. S6 do nay
dwoc thé hién dwa trén ty 1& tuyét déi, (murc
do Kelvin). Cac muc nhiét dé Kevin thap
hon nhw 2004K [a mau do; cac mirc nhiét
dé cao hon nhw 9300K la mau lam. Nhiét
dd trung tinh 1& mau trdng & mirc 6504K.

H9:

Dap:

T6i c6 thé két ndi man hinh LCD
v&i moi PC, may chu hay may
Mac?

Co thé. Tat ca cac man hinh LCD
Philips déu hoan toan twong thich
v&i cac PC, may Mac va may cha
chuan. Ban co6 thé can cé dau néi
cap dé két néi man hinh méi hé
théng may Mac. Vui long lién hé voi
nhan vién kinh doanh cla Philips dé
biét thém thong tin.
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H10: Man hinh LCD Philips c6 hé tro
chuén Plug-and-Play (Cam vao la
phat)?

DPap: Co6, cac man hinh Philips déu hé tro
chuan Plug-and-Play twong thich
v@i Windows 7/Windows 8/Vista/XP/
NT, Mac OSX, Linux

H11: Anh chap chon hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

DPap: Hién thi lién tuc cac anh tinh trong
mot thdi gian dai cé thé gay ra hién
twong “anh thir néng”, con dwoc
goi la “anh ao” hay “anh bong ma”,
trén man hinh cla ban. “Anh thir
nong”, “Anh &o” hay “Anh béng ma”
la hién twong phd bién trong coéng
nghé man hinh LCD. Trong moi
treong hop, hién twong “anh thiy
néng” hay “anh ao” hay “anh béng
ma” sé bién mét dan trong mot thoi
gian sau khi da t&t nguén.

Ludn bat trinh bao vé man hinh
chuyén déng khi ban khéng st
dung man hinh.

Ludn bat xng dung lam md&i man
hinh dinh ky, néu khéng, man hinh
LCD cua ban sé hién thj nhirng noi
dung tinh khéng thay dbi.

? canh bao

Khéng thé bat anh bao vé man hinh, hoac
trng dung cap nhat man hinh dinh ky cé
thé gay ra cac sw cd “thr néng” hodc “anh
sau” hoac “anh bong ma” nghiém trong
von sé khéng bién mét va ciing khéng

thé khac phuc. Thiét hai vira néu khéng
bao gbm trong chinh sach bao hanh cua
chung toi.

H12: Tai sao man hinh cua t6i hién thi
van ban sic nét va cac ky tw rang
cwa?

Pap: Man hinh LCD cua ban hoat déng
tét nhat & dé phan giai géc 1920 x
1080 @ 60 Hz. D& man hinh hién



thj t&t nhat, vui long st dung dd
phan giai nay.

H13: Lam thé nao dé mé khoéalkhéa

phim néng cua t6i?

Pap: Vui long nhan phim /0K trong
10 giay dé mé khoa/khoa phim
néng; khi thwe hién thao tac
nay, man hinh cua ban sé bat
lén thong bao “Chu y” dé hién
thi tinh trang mé khéa/khéa nhw
trinh bay dwéi cac hinh minh
hoa.

Attention

Monitor controls locked

Attention

Monitor control unlocked
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